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Membuat Database Koperasi 
 
 
 
 
 
 
 

 

Sekarang kita akan mulai membuat database koperasi. Pembahasan 
mulai bab ini mengharuskan Anda duduk menghadapi komputer, 
dan melakukan langkah-langkah yang diinstruksikan. 

3.1 Membuat File Database 
Langkah pertama dalam membuat database adalah membuat file 
database. File database merupakan file fisik yang dibuat pada 
komputer. 

3.1.1 Membuat File Database pada Microsoft Access 2003 

Untuk membuat file database pada Microsoft Access 2003, jalankan 
Microsoft Access, lalu lakukan langkah-langkah berikut: 

1. Klik menu File > New atau tekan Ctrl+N. 

2. Muncul Task Pane di sebelah kanan. 

3. Klik “Blank Database…” 
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Gambar 3-1. Membuat file database 

4. Tentukan lokasi penyimpanan dan nama file database. 

Pada contoh dalam buku ini kita menyimpan file database de-
ngan nama: DBKoperasi_2003.mdb. 

Lokasi penyimpanan boleh pada My Documents, Desktop, atau 
folder lain yang Anda tentukan. 

5. Klik “Create”. 

Tampak jendela database (database window) sebagai berikut: 

 

Gambar 3-2. Jendela Database 
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Jika tampilan pada jendela database Anda menunjukkan file format 
yang berbeda (bukan 2002-2003, lihat pada title bar jendela 
database), sebenarnya tidak masalah, namun Anda tidak bisa 
menyimpan database ke dalam file .ade (file database yang di-
distribusikan kepada pemakai di mana pemakai tidak bisa lagi 
menampilkan dan memodifikasi desain object aplikasi). 

Untuk mengubah format file database, Anda bisa melakukan 
konversi, atau membuat ulang database dengan format file yang 
diinginkan. 

Jika Anda memilih untuk melakukan konversi, lakukan langkah-
langkah berikut: 

1. Dalam keadaan file database sedang terbuka, klik menu Tools > 
Database Utilities > Convert Database dan pilih file format yang 
diinginkan. 

2. Tentukan lokasi penyimpanan dan nama file database hasil 
konversi. 

3. Klik “Save”. 

Jika Anda memilih membuat ulang file database, lakukan langkah-
langkah berikut: 

1. Dalam keadaan sebuah file database sedang terbuka, klik menu 
Tools > Options. 

2. Klik tab Advanced. 

3. Pilih “Access 2002 – 2003” pada Default File Format. 

4. Klik “OK”. 
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Gambar 3-3. Menentukan format file default 

Sekarang Anda bisa membuat file database baru dalam format file 
Access 2002 – 2003. 

3.1.2 Membuat File Database pada Microsoft Access 2007 

Untuk membuat file database pada Microsoft Access 2007, jalankan 
Microsoft Access, lalu lakukan langkah-langkah berikut: 

1. Klik tombol Office (tombol bulat di pojok kiri-atas). 

2. Klik “New”. 

3. Klik “Blank Database”. 

4. Klik tombol folder untuk menentukan lokasi penyimpanan dan 
nama file database. 
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Gambar 3-4. Membuat file database pada Access 2007 

Pada contoh dalam buku ini kita memberi nama file database: 
DBKoperasi_2007.accdb. 

Lokasi penyimpanan boleh pada My Documents, Desktop, atau 
folder lain yang Anda tentukan. 

5. Klik “Create”. 

3.1.3 Membuat File Database pada Microsoft Access 2010 

Untuk membuat file database pada Microsoft Access 2010, jalankan 
Microsoft Access, lalu lakukan langkah-langkah berikut: 

1. Klik menu/tab File. 

2. Klik “New”. 

3. Klik “Blank Database” pada Available Templates. 
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Gambar 3-5. Membuat file database pada Access 2007 

4. Klik tombol folder untuk menentukan lokasi penyimpanan dan 
nama file database. 

Pada contoh dalam buku ini kita memberi nama file database: 
DBKoperasi_2010.accdb. 

Lokasi penyimpanan boleh pada My Documents, Desktop, atau 
folder lain yang Anda tentukan. 

5. Klik “Create”. 

3.2 Membuat Table Data 
Table adalah object database yang digunakan untuk menyimpan 
data. Pembuatan table merupakan langkah kedua dalam membuat 
database. 

Berdasarkan rancangan database yang dibuat di depan, kita perlu 
membuat table-table sebagai berikut: 

• Table Data Anggota, yaitu table untuk menyimpan data anggota. 

• Table Data Simpanan, yaitu table untuk menyimpan data 
simpanan anggota. Table data simpanan ini perlu dilengkapi juga 
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dengan table untuk menyimpan data pengambilan simpanan 
oleh anggota (misalnya karena anggota keluar dari keanggotaan 
koperasi). 

• Table Data SHU, yaitu table untuk menyimpan data SHU. 

3.2.1 Table Data Anggota 

Untuk membuat table data anggota pada Microsoft Access 2003, 
ikuti langkah-langkah berikut: 

1. Pada jendela Database, klik kategori object “Table”, lalu klik 
“New” atau klik-ganda “Create table in Design view”. 

 

Gambar 3-6. Membuat table pada Microsoft Access 2003 

2. Buatlah struktur field hingga menjadi sebagai berikut: 

 

Gambar 3-7. Membuat struktur field table data anggota 
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Struktur field di atas adalah: 

Field Name  Data Type  Field Size 

RecID  AutoNumber  Long Integer 

RecTime  Date/Time   

NomorAnggota  Text  10 

NamaAnggota  Text  50 

JenisKelamin  Text  1 

Agama  Text  15 

TempatLahir  Text  50 

TanggalLahir  Date/Time   

Perusahaan  Text  10 

UnitKerja  Text  10 

Lokasi  Text  10 

Alamat  Text  255 

Kota  Text  50 

KodePos  Text  10 

Telepon  Text  50 

TanggalMasuk  Date/Time   

TanggalKeluar  Date/Time   

FileFoto  Text  50 

Catatan  Memo   
 

3. Untuk field RecTime, isi properti Default Value dengan Now(). 

 

Gambar 3-8. Mengatur properti field 

4. Untuk field TanggalLahir, TanggalMasuk, dan TanggalKeluar, 
pilih properti Format: Short Date. 

5. Klik field NomorAnggota, lalu klik ikon kunci pada toolbar Table 
Design untuk menjadikannya kunci primer (primary key). 
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Gambar 3-9. Menentukan primary key pada Microsoft Access 
2003 

6. Klik ikon disket pada toolbar Table Design untuk menyimpan 
table. Beri nama table: tbl_Anggota. 

7. Klik tombol “x” untuk menutup table (atau klik menu File > 
Close atau tekan Ctrl+F4). 

 

Jika Anda menggunakan Microsoft Access 2007, tata cara pem-
buatan table adalah sebagai berikut: 

1. Klik ribbon tab Create, klik “Table Design”. 

 

Gambar 3-10. Membuat table pada Microsoft Access 2007 

2. Masukkan struktur field table data anggota seperti pada pem-
buatan table dengan Microsoft Access 2003 di atas, dengan 
perkecualian: 

Field FileFoto diganti menjadi: 

Foto  Attachment   
 

3. Seperti pada pembuatan table dengan Microsoft Access 2003, isi 
properti Default Value untuk field RecTime dengan Now(). 

4. Lakukan juga pengaturan properti Format untuk field-field 
TanggalLahir, TanggalMasuk, dan TanggalKeluar dengan format 
“Short Date”. 

5. Untuk menentukan field NomorAnggota sebagai primary key, 
klik ribbon tab Design, klik “Primary Key”. 
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Gambar 3-11. Menentukan primary key pada Microsoft Access 
2007 

6. Klik ikon disket pada Quick Access Toolbar untuk menyimpan 
table. Beri nama table: tbl_Anggota. 

7. Klik tombol “x” untuk menutup table (atau klik-kanan tab object 
table tersebut dan pilih “Close”, atau tekan Ctrl+F4). 

 

Gambar 3-12. Menutup table dengan klik-kanan 

Mungkin Anda memperhatikan bahwa ukuran field (field size) default 
yang disediakan Access 2007 untuk tipe data Text adalah 255, 
sementara Anda lebih banyak membutuhkan ukuran sebesar 50. 
Jika Anda ingin mengubah ukuran field default ini sehingga mem-
percepat dalam pembuatan table, ikuti langkah-langkah berikut: 

1. Klik tombol Office. 

2. Klik tombol “Access Options” (di bagian bawah). 

3. Pada jendela Access Options, klik “Object Designers”. 

4. Ubah ukuran field default untuk tipe data yang terpilih (di bagian 
kanan). 
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Gambar 3-13. Mengubah ukuran default field Text 

5. Klik “OK”. 

Adapun jika Anda menggunakan Microsoft Access 2010, tata cara 
pembuatan table hampir sama dengan tata cara pada Microsoft 
Access 2007 sehingga Anda bisa mengikutinya. 

Catatan: Walaupun Anda menggunakan Access 2007 atau Access 
2010, Anda tetap perlu membaca uraian untuk Access 2003. Seperti 
telah diutarakan pada Bab-1, saya membuat aplikasi database 
koperasi pertama kali dengan Access 2003. Demikian pula pem-
bahasan dalam buku ini, saya membahas terlebih dahulu peng-
gunaan Access 2003. Namun jika tata cara yang dilakukan sama, 
saya tidak membahas lagi untuk Access 2007 dan Access 2010. 

Berikut ini adalah penjelasan tentang struktur field table data 
anggota: 

• Field RecID berisi angka otomatis (Autonumber) yang diisi oleh 
Access. Angka ini berurutan sehingga kita bisa mengguna-
kannya sebagai identitas record, atau sebagai kunci jika kita 
ingin mengurutkan record berdasarkan kronologi penciptaannya. 

Field ini tidak harus ada, namun dari pengalaman saya, field ini 
banyak gunanya sehingga saya selalu menambahkannya. 

• Field RecTime berisi tanggal dan waktu penciptaan record. Data 
tanggal dan waktu ini diisi secara otomatis karena kita telah 
memasang function Now() pada properti Default Value-nya. 



24 

Sama seperti filed RecID, field RecTime tidak harus ada, namun 
akan banyak gunanya jika kita ingin menjejak (trace) penciptaan 
record. 

• Ukuran field NomorAnggota kita buat selebar 10 karakter. Jika 
pada koperasi Anda ternyata nomor anggota lebih dari 10 
karakter, Anda bisa membesarkannya. 

Perlu diketahui bahwa pada Access, data yang disimpan adalah 
data yang dimasukkan pada field, tidak termasuk spasi di 
belakangnya jika ukuran data tersebut kurang dari ukuran field. 

• Ukuran field JenisKelamin hanya 1 karakter, yang akan kita isi 
dengan “L” untuk “Laki-laki” dan “P” untuk perempuan. Untuk 
menampilkan data sebagai “Laki-laki” dan “Perempuan” bisa di-
lakukan melalui Lookup. 

• Field Perusahaan, UnitKerja, dan Lokasi berukuran 10 karakter. 
Field-field ini hanya menyimpan kode dari perusahaan, unit 
kerja, dan lokasi, sedangkan data perusahaan, unit kerja, dan 
lokasi tersebut disimpan pada table lain (table pendukung). 

• Field TanggalMasuk digunakan untuk menyimpan data tanggal 
anggota menjadi anggota koperasi. 

• Field TanggalKeluar digunakan untuk menyimpan data tanggal 
anggota keluar dari keanggotaan koperasi. 

• Pada Access 2003 kita menggunakan field FileFoto. Field ini 
menyimpan data nama file gambar foto anggota. Di sini kita 
akan menggunakan sedikit trik untuk menampilkan gambar foto. 

Pada Access 2007 dan Access 2010 kita bisa menyimpan 
gambar foto dalam database (pada field Foto) dan menam-
pilkannya tanpa masalah, yaitu dengan menggunakan tipe data 
Attachment. 

• Field Catatan digunakan untuk merekam catatan atau informasi 
lain tentang anggota. Tipe data Memo bisa menampung banyak 
informasi (hingga 63.999 karakter). 
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3.2.2 Table Data Simpanan 

Dengan menggunakan cara yang sama ketika membuat table data 
anggota, buatlah table data simpanan dengan struktur sebagai ber-
ikut: 

Field Name  Data Type  Field Size 

RecID  AutoNumber  Long Integer 

RecTime  Date/Time   

NomorAnggota  Text  10 

JenisSimpanan  Text  1 

TanggalSimpan  Date/Time   

PeriodeTahun  Number  Integer 

PeriodeBulan  Number  Byte 

Jumlah  Currency   

• Untuk field RecTime, properti Default Value isi dengan Now(). 

• Untuk field TanggalSimpan, properti Format isi dengan “Short 
Date”. 

• Untuk field Jumlah, properti Format isi dengan “Standard”, dan 
properti Decimal Places isi dengan 0. 

• Jadikan field RecID sebagai primary key. 

Simpan table dengan nama: tbl_Simpanan. 

Berikut ini penjelasan tentang struktur field table data simpanan: 

• Field JenisSimpanan menyimpan data kode jenis simpanan. 
Adapun data jenis simpanan disimpan pada table tersendiri. 

• Field TanggalSimpan menyimpan data tanggal simpanan di-
terima oleh petugas. Tanggal ini tidak selalu bersamaan dengan 
periode simpanan, misalnya simpanan wajib bulan Pebruari 
tahun 2011 baru diterima pada tanggal 15 Maret 2011. 

• Field PeriodeTahun dan PeriodeBulan menyimpan data periode 
simpanan (tahun dan bulan). Dalam hal ini periode simpanan 
adalah bulanan, yaitu periode untuk simpanan wajib. Untuk 
simpanan pokok dan simpanan sukarela yang tidak rutin, tetap 
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bisa dimasukkan dalam periode bulan dan tahun, walaupun tidak 
harus selalu ada dalam setiap periode. 

• Field Jumlah menggunakan tipe data Currency karena tipe data 
ini adalah yang paling sesuai untuk menyimpan data yang 
berhubungan dengan uang. 

3.2.3 Table Data Pengambilan Simpanan 

Seperti telah dikemukakan, table data simpanan perlu dilengkapi 
dengan table untuk menyimpan data pengambilan simpanan. Untuk 
itu buatlah sebuah table baru dengan struktur sebagai berikut. 
Simpan dengan nama: tbl_Simpanan_ambil. 

Field Name  Data Type  Field Size 

RecID  AutoNumber  Long Integer 

RecTime  Date/Time   

NomorAnggota  Text  10 

JenisSimpanan  Text  1 

TanggalAmbil  Date/Time   

Jumlah  Currency   

Keterangan  Text  255 

• Untuk field RecTime, properti Default Value isi dengan Now(). 

• Untuk field Jumlah, properti Format isi dengan “Standard”, dan 
properti Decimal Places isi dengan 0. 

• Jadikan field RecID sebagai primary key. 

3.2.4 Table Data SHU 

Buatlah table data SHU dengan struktur field sebagai berikut: 

Field Name  Data Type  Field Size 

RecID  AutoNumber  Long Integer 

RecTime  Date/Time   

NomorAnggota  Text  10 

PeriodeTahun  Number  Integer 
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SHU_MU  Currency   

SHU_AE  Currency   

• Untuk field RecTime, properti Default Value isi dengan Now(). 

• Untuk field SHU_MU dan SHU_AE, properti Format isi dengan 
“Standard”, dan properti Decimal Places isi dengan 0. 

• Jadikan field RecID sebagai primary key. 

Simpan table dengan nama: tbl_SHU. 

Berikut ini adalah penjelasan tentang struktur field table data SHU: 

• Field PeriodeTahun menyimpan data periode SHU, dalam hal ini 
periode SHU adalah tahunan. 

• Field SHU_MU menyimpan data SHU karena Modal Usaha (yaitu 
jumlah simpanan modal anggota). 

• Field SHU_AE menyimpan data SHU karena Aktivitas Ekonomi 
(yaitu jumlah transaksi anggota terhadap koperasi). 

3.3 Membuat Table Pendukung 
Table pendukung adalah table yang diperlukan untuk melengkapi 
table data. 

Perlu diketahui bahwa di dalam penyusunan database terdapat 
kaidah dan aturan-aturan yang perlu diikuti, antara lain tidak boleh 
terjadi duplikasi data, yaitu pencatatan data yang sama berulang-
ulang sehingga bisa menyebabkan inkonsistensi. Untuk menghindari 
duplikasi data tersebut dilakukan pemecahan table menjadi beberapa 
table, di mana data yang sama disimpan pada table yang lain 
sehingga cukup dicatat sekali. 

Table pendukung kadang-kadang disebut juga sebagai table 
“master” karena dirujuk oleh table yang menyimpan “detail” data. 

Adapun table pendukung yang diperlukan adalah: 

• Table Jenis Simpanan, yang menyimpan daftar jenis simpanan 
anggota. 
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• Table Perusahaan, yang menyimpan daftar perusahaan. 

• Table Unit Kerja, yang menyimpan daftar unit kerja. 

• Table Lokasi, yang menyimpan daftar lokasi (keberadaan) ang-
gota. 

Perlu diketahui bahwa saya menyusun database koperasi ini meng-
gunakan contoh koperasi karyawan sehingga di dalam struktur data 
terdapat item data perusahaan, unit kerja, dan lokasi (keberadaan) 
karyawan. 

Tentu saja item data ini mungkin tidak relevan dengan koperasi 
Anda, dan Anda bisa menambahkan item-item data yang lebih 
sesuai atau lebih dibutuhkan pada koperasi Anda. 

Selain table pendukung di atas, kita juga memerlukan table pen-
dukung yang lain yang sebenarnya bukan berasal dari pemecahan 
table data, namun diperlukan untuk menjaga konsistensi data. 

Table pendukung tambahan tersebut adalah: 

• Table Agama, yang menyimpan daftar agama sehingga isian 
agama pada data anggota bisa konsisten berdasarkan daftar 
yang kita sediakan. 

• Table Bulan, yang menyimpan daftar nama bulan sehingga kita 
tinggal menyimpan data angka bulan pada table data simpanan, 
dan penampilan nama bulan menjadi konsisten. 

• Table Tahun, yang menyimpan teks tampilan tahun, misalnya 
“2010-2011” untuk tahun 2010 (karena periode tahun fiskal 
koperasi mungkin tidak dimulai dari tanggal 1 Januari s/d 31 
Desember). 

• Table Pecahan Uang, yang menyimpan daftar pecahan uang 
yang tersedia untuk pembagian SHU. 

3.3.1 Table Jenis Simpanan 

Buatlah table Jenis Simpanan dengan struktur sebagai berikut: 

Field Name  Data Type  Field Size 

JenisSimpanan  Text  1 

NamaSimpanan  Text  50 
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Jumlah  Currency   

Urutan  Number  Byte 

Field JenisSimpanan dijadikan sebagai primary key. 

Untuk field Jumlah, atur properti Format = “Standard” dan properti 
Decimal Places = 0. 

Simpan table dengan nama: tbl_JenisSimpanan. 

Selanjutnya, buka tbl_JenisSimpanan dalam Datasheet View. 

Caranya: 

Jika Anda menggunakan Access 2003, ketika table sedang terbuka 
dalam Design View, klik “View” pada toolbar atau menu, lalu pilih 
“Datasheet View”. 

 

Gambar 3-14. Menampilkan table dalam Datasheet View 

Jika Anda ingin menampilkan table dari jendela Database, klik-
ganda object table tersebut. 

Pada tampilan datasheet, isi data sebagai berikut: 

 

Gambar 3-15. Mengisi data jenis simpanan 

Jika Anda menggunakan Access 2007 atau Access 2010, ketika 
table sedang terbuka dalam Table Design, klik “View” pada ribbon 
tab Design. 
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Untuk membuka table dalam Datasheet View dari Navigation Pane, 
klik-ganda object table tersebut. 

 

Gambar 3-16. Menampilkan table dalam Datasheet View pada 
Access 2010 

Isilah table dengan data seperti pada Gambar 3-15. 

Perlu diketahui bahwa nilai pada field Jumlah adalah besar simpanan 
anggota, yang dalam contoh ini besar simpanan pokok anggota 
adalah Rp 100.000,- dan besar simpanan wajib juga Rp 100.000,- 
Anda bisa mengisi nilai simpanan ini sesuai dengan ketentuan pada 
koperasi Anda. 

3.3.2 Table Perusahaan 

Buatlah table Perusahaan dengan struktur sebagai berikut: 

Field Name  Data Type  Field Size 

KodePerusahaan  Text  10 

NamaPerusahaan  Text  50 

Filed KodePerusahaan dijadikan primary key. 

Simpan table dengan nama: tbl_Perusahaan. 

Kemudian bukalah table Perusahaan dalam Datasheet View lalu 
masukkan kode dan nama perusahaan, misalnya seperti pada 
contoh sebagai berikut. Anda bisa memasukkan daftar perusahaan 
yang sesuai dengan koperasi Anda, atau tidak memasukkan data 
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perusahaan jika memang data ini tidak relevan dengan koperasi 
Anda. 

 

Gambar 3-17. Contoh data Perusahaan 

3.3.3 Table Unit Kerja 

Buatlah table Unit Kerja dengan struktur sebagai berikut: 

Field Name  Data Type  Field Size 

KodeUnitKerja  Text  10 

NamaUnitKerja  Text  50 

Filed KodeUnitKerja dijadikan primary key. 

Simpan table dengan nama: tbl_UnitKerja. 

Kemudian bukalah table Unit Kerja dalam Datasheet View lalu 
masukkan data unit kerja jika ada. 

 

Gambar 3-18. Contoh data unit kerja 

3.3.4 Table Lokasi 

Buatlah table Lokasi dengan struktur sebagai berikut: 

Field Name  Data Type  Field Size 

KodeLokasi  Text  10 

NamaLokasi  Text  50 



32 

Filed KodeLokasi dijadikan primary key. 

Simpan table dengan nama: tbl_Lokasi. 

Kemudian bukalah table Lokasi dalam Datasheet View lalu ma-
sukkan data lokasi jika ada. 

 

Gambar 3-19. Contoh data lokasi 

3.3.5 Table Agama 

Buatlah table Agama dengan struktur sebagai berikut: 

Field Name  Data Type  Field Size 

Agama  Text  15 

Urutan  Number  Byte 

Filed Agama dijadikan primary key. 

Field Urutan disediakan untuk mengurutkan tampilan data agama. 

Simpan table dengan nama: tbl_Agama. 

Kemudian bukalah table Agama dalam Datasheet View lalu ma-
sukkan data sebagai berikut: 

 

Gambar 3-20. Isi table Agama 
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3.3.6 Table Bulan 

Buatlah table Bulan dengan struktur sebagai berikut: 

Field Name  Data Type  Field Size 

Bulan  Number  Byte 

NamaBulan  Text  15 

Filed Bulan dijadikan primary key. 

Simpan table dengan nama: tbl_Bulan. 

Kemudian bukalah table Bulan dalam Datasheet View lalu masukkan 
data sebagai berikut: 

 

Gambar 3-21. Isi table Bulan 

3.3.7 Table Tahun 

Buatlah table Tahun dengan struktur sebagai berikut: 

Field Name  Data Type  Field Size 

Tahun  Number  Integer 

TampilanTahun  Text  10 

Filed Tahun dijadikan primary key. 

Simpan table dengan nama: tbl_Tahun. 
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Kemudian bukalah table Tahun dalam Datasheet View lalu masuk-
kan data sebagai berikut: 

 

Gambar 3-22. Contoh isi table Tahun 

3.3.8 Table Pecahan Uang 

Buatlah table Pecahan Uang dengan struktur sebagai berikut: 

Field Name  Data Type  Field Size 

Pecahan  Currency   

Dipakai  Yes/No   

Field Pecahan dijadikan primary key. 

Simpan table dengan nama: tbl_PecahanUang. 

Kemudian bukalah table Pecahan uang dalam Datasheet View lalu 
masukkan data sebagai berikut: 

 

Gambar 3-23. Isi table Pecahan Uang 

Hingga di sini kita telah selesai membuat table-table yang dibu-
tuhkan. Langkah selanjutnya adalah membuat relasi atau hubungan 
antar-table tersebut. 
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3.4 Membuat Relationship 
Relationship adalah definisi hubungan antar-table. Relationship tidak 
harus dibuat, namun jika dibuat akan memberi keuntungan sebagai 
berikut: 

• Menjaga integritas data, misalnya kita tidak bisa memasukkan 
data pada table detail jika data tersebut belum tersedia pada 
table master. Tambahannya, jika data pada table master diubah, 
data pada table detail bisa ikut berubah secara otomatis sehingga 
selalu terjadi konsistensi. 

• Ketika membuat query berdasarkan table-table yang berhu-
bungan, Access akan otomatis membuat relasi antar-table 
tersebut. 

• Kita bisa mengetahui keterkaitan antar-table dengan mudah. 

Untuk membuat relationship pada Access 2003, ikuti langkah-
langkah berikut: 

1. Klik menu Tools > Relationships. Muncul jendela Relationships. 

 

Gambar 3-24. Kotak Show Table pada jendela Relationships 

2. Pada kotak Show Table, pilih table yang ingin ditambahkan ke 
dalam relationship. Anda bisa memilih lebih dari satu table 
sekaligus dengan menekan Ctrl atau Shift sambil klik. 

Sekarang tambahkan table-table sebagai berikut ke dalam 
relationship: 
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tbl_Agama 

tbl_Anggota 

tbl_JenisSimpanan 

tbl_Lokasi 

tbl_Perusahaan 

tbl_SHU 

tbl_Simpanan 

tbl_Simpanan_ambil 

tbl_UnitKerja 

3. Aturlah letak kotak table sehingga memudahkan Anda membuat 
garis relasinya. 

 

Gambar 3-25. Relationship untuk database koperasi 

4. Untuk membuat garis relasi, seret (drag) field yang ingin di-
relasikan dari suatu table lalu jatuhkan (drop) tepat di atas field 
yang berkaitan pada table tujuan. Antara table “asal” dan table 
“tujuan” bisa bolak-balik (tidak harus menetapkan mana table 
asal atau table tujuan). 
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Relasi yang perlu Anda buat adalah: 

(dalam format NamaTable.NamaField) 

• tbl_Agama.Agama ↔ tbl_Anggota.Agama 

• tbl_Perusahaan.KodePerusahaan ↔ tbl_Anggota.Perusahaan 

• tbl_UnitKerja.KodeUnitKerja ↔ tbl_Anggota.UnitKerja 

• tbl_Lokasi .KodeLokasi ↔ tbl_Anggota.Lokasi 

• tbl_Anggota.NomorAnggota ↔ tbl_Simpanan.NomorAnggota 

• tbl_Anggota.NomorAnggota ↔ 
tbl_Simpanan_ambil.NomorAnggota 

• tbl_Anggota.NomorAnggota ↔ tbl_SHU.NomorAnggota 

• tbl_Simpanan.JenisSimpanan ↔ 
tbl_JenisSimpanan.JenisSimpanan 

• tbl_Simpanan_ambil.JenisSimpanan ↔ 
tbl_JenisSimpanan.JenisSimpanan 

5. Setiap kali Anda membuat relasi, akan muncul kotak Edit 
Relationships. 

Perhatikanlah nama table dan nama field yang akan direlasikan. 

Beri tanda centang pada opsi “Enforce Referential Integrity”, lalu 
beri tanda centang pula pada opsi “Cascade Update Related 
Fields”. Kedua pilihan ini akan menerapkan referential integrity 
(yaitu tidak menerima data pada table detail jika data tersebut 
belum ada pada table master), dan setiap perubahan data pada 
table master akan mengubah pula data pada table detail. 

 

Gambar 3-26. Membuat relasi antar-table 
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Opsi “Cascade Delete Related Records” akan menghapus setiap 
record pada table detail jika record yang berkaitan pada table 
master dihapus. Opsi ini tidak kita gunakan di sini karena kita 
ingin mempertahankan record pada table detail walaupun akan 
menjadi “orphan”. 

Perlu diketahui bahwa yang disebut table master adalah table 
yang memiliki field (yang direlasikan) yang merupakan primary 
key. Table ini disebut juga sisi “one” dalam relasi antar-table 
tersebut, sedangkan table lawannya disebut sisi “many” (relasi 
yang dibuat disebut “one-to-many”). Table sisi “one” dilambang-
kan dengan angka 1 pada garis relasi sementara table sisi 
“many” dilambangkan dengan tanda ∞. 

 

Jika Anda menggunakan Access 2007 atau Access 2010, langkah-
langkahnya adalah sebagai berikut: 

1. Pada saat database sedang terbuka, klik ribbon tab Database 
Tools, klik “Relationships”. 

 

Gambar 3-27. Relationships pada ribbon tab Database Tools 

2. Tambahkan table-table yang ingin direlasikan lalu buat relasi 
seperti pada pembuatan relationship menggunakan Access 2003 
di atas. 

3.5 Membuat Lookup 
Lookup adalah fitur yang disediakan Access untuk menampilkan 
pilihan data, misalnya untuk field Jenis Kelamin tersedia pilihan 
“Laki-laki” dan “Perempuan”, untuk field Jenis Simpanan tersedia 
pilihan “Pokok”, “Wajib”, dan “Sukarela”, dan sebagainya. 
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Gambar 3-28. Contoh tampilan Lookup 

Pembuatan Lookup tidak harus dilakukan, namun jika dilakukan 
akan memberikan manfaat sebagai berikut: 

• Untuk memudahkan pemakai dalam memasukkan data, yaitu 
tinggal memilih dari data yang tersedia. 

• Untuk membatasi data yang bisa dimasukkan pemakai. 

• Untuk menampilkan data yang lebih mudah dibaca/dimengerti 
padahal data yang sebenarnya bukan itu. Contohnya adalah data 
Jenis Kelamin, di mana data yang sebenarnya adalah “L” atau 
“P” tetapi yang ditampilkan adalah “Laki-laki” atau “Perempuan”. 

Sebenarnya, penggunaan control Combo Box untuk menampilkan 
pilihan data bisa dilakukan langsung pada form atau report. Namun 
jika kita membuat Lookup pada table, maka ketika field yang yang 
mempunyai Lookup tersebut ditampilkan (dalam datasheet) atau 
ditambahkan pada form dan report, maka pengaturan Lookup-nya 
otomatis mengikuti. 

3.5.1 Lookup pada Table Anggota 

Berikut ini adalah beberapa Lookup yang perlu Anda buat pada table 
Anggota. Untuk membuatnya, bukalah table tbl_Anggota dalam 
Design View. 

• Lookup JenisKelamin 

Lookup JenisKelamin didasarkan pada data yang kita sediakan 
secara langsung (diketik/dimasukkan), yaitu “L” untuk “Laki-
laki” dan “P” untuk “Perempuan”. Karena diketik sendiri, tipe 
sumber data Lookup ini disebut “Value List”. 

Klik field JenisKelamin, lalu klik tab Lookup pada Field 
Properties. 
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Pilih “Combo Box” sebagai Display Control, lalu atur properti lain 
hingga menjadi sebagai berikut: 

 

Gambar 3-29. Membuat Lookup Jenis Kelamin 

Properti yang perlu diatur adalah: 

Display Control Combo Box 
Row Source Type Value List 
Row Source L;Laki-laki;P;Perempuan 
Bound Column 1 
Column Count 2 
Column Widths 0cm;1cm 
List Width 1cm 
Limit To List Yes 

Catatan: Properti yang tidak dicantumkan di sini dibiarkan se-
bagaimana aslinya. 

 

• Lookup Agama 

Lookup Agama didasarkan pada table Agama yang sudah kita 
buat. 
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Klik field Agama lalu atur properti Lookup sebagai berikut: 

Display Control Combo Box 
Row Source Type Table/Query 
Row Source SELECT tbl_Agama.Agama, 

tbl_Agama.Urutan FROM tbl_Agama 
ORDER BY tbl_Agama.Urutan; 

Bound Column 1 
Column Count 1 
Column Widths  
List Width 1cm 
Limit To List No 

Isi properti Row Source di atas merupakan perintah SQL atau 
query. Untuk membuatnya lakukan langkah-langkah berikut: 

1. Klik tombol Build ( ) di sebelah kanan isian properti. 

2. Muncul Query Builder. Pada kotak Show Table, pilih 
tbl_Agama. Klik “Add” lalu klik “Close”. 

3. Klik-ganda field Agama dari kotak field untuk memasuk-
kannya ke dalam grid. Anda bisa juga menyeret field 
langsung ke dalam kolom pada grid. 

Masukkan pula field Urutan ke dalam grid. 

4. Di bawah kolom Urutan, pilih Sort: Ascending. 

5. Hilangkan tanda centang pada baris Show kolom Urutan. 

 

Gambar 3-30. Membuat query untuk Row Source 
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6. Klik tombol “x” untuk menutup Query Builder (atau pilih 
menu File > Close pada Access 2003). 

7. Klik “Yes” pada pertanyaan konfirmasi. 
 

• Lookup Tempat Lahir 

Lookup Tempat Lahir didasarkan pada nama kota yang di-
masukkan pemakai pada field TempatLahir, serta dikom-
binasikan juga dengan nama kota yang dimasukkan pada field 
Kota (alamat). Dengan cara ini pemakai bisa memilih dari nama 
kota yang sudah pernah dimasukkan, atau menambahkan nama 
kota baru jika belum ada dalam pilihan. 

Untuk menyediakan data nama kota yang sudah pernah di-
masukkan, kita perlu membuat sebuah query, yang disimpan 
dengan nama qry_Kota (akan dibahas tersendiri di seksi se-
lanjutnya dalam bab ini. Untuk saat ini Anda bisa langsung 
memasukkan nama query tersebut pada properti Row Source). 

Klik field TempatLahir lalu atur properti Lookup sebagai berikut: 

Display Control Combo Box 
Row Source Type Table/Query 
Row Source qry_Kota 
Bound Column 1 
Column Count 1 
Column Widths  
List Width 1cm 
Limit To List No 

 

• Lookup Perusahaan 

Lookup Perusahaan didasarkan pada table Perusahaan yang 
sudah kita buat. 

Klik field Perusahaan lalu atur properti Lookup sebagai berikut: 

Display Control Combo Box 
Row Source Type Table/Query 
Row Source tbl_Perusahaan 
Bound Column 1 
Column Count 2 
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Column Widths 0cm;1cm 
List Width 1cm 
Limit To List Yes 

 
• Lookup Unit Kerja 

Lookup Unit Kerja didasarkan pada table Unit Kerja yang sudah 
kita buat. 

Klik field UnitKerja lalu atur properti Lookup sebagai berikut: 

Display Control Combo Box 
Row Source Type Table/Query 
Row Source tbl_UnitKerja 
Bound Column 1 
Column Count 2 
Column Widths 0cm;1cm 
List Width 1cm 
Limit To List Yes 

 

• Lookup Lokasi 

Lookup Lokasi didasarkan pada table Lokasi yang sudah kita 
buat. 

Klik field Lokasi lalu atur properti Lookup sebagai berikut: 

Display Control Combo Box 
Row Source Type Table/Query 
Row Source tbl_Lokasi 
Bound Column 1 
Column Count 2 
Column Widths 0cm;1cm 
List Width 1cm 
Limit To List Yes 

 

• Lookup Kota 

Lookup Kota sama dengan Lookup Tempat Lahir, yaitu ber-
dasarkan nama kota yang pernah dimasukkan pemakai pada 
field TempatLahir dan field Kota. Data nama kota tersebut 
disediakan oleh query qry_Kota.  
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Klik field Kota lalu atur properti Lookup sebagai berikut: 

Display Control Combo Box 
Row Source Type Table/Query 
Row Source qry_Kota 
Bound Column 1 
Column Count 1 
Column Widths  
List Width 1cm 
Limit To List No 

 

3.5.2 Lookup pada Table Simpanan 

Selanjutnya bukalah table tbl_Simpanan dalam Design View, lalu 
buat Lookup sebagai berikut: 

• Lookup NomorAnggota 

Lookup Nomor Anggota disediakan agar pemakai tinggal me-
milih nomor anggota dari data yang disimpan pada table 
Anggota. 

Di sini kita bisa menampilkan dua buah kolom yaitu kolom 
nomor anggota dan kolom nama anggota. 

Klik field NomorAnggota lalu atur properti Lookup sebagai ber-
ikut: 

Display Control Combo Box 
Row Source Type Table/Query 
Row Source SELECT tbl_Anggota.NomorAnggota, 

tbl_Anggota.NamaAnggota FROM 
tbl_Anggota ORDER BY 
tbl_Anggota.NomorAnggota; 

Bound Column 1 
Column Count 2 
Column Widths 2cm;1cm 
List Width 8cm 
Limit To List Yes 

 

Untuk membuat query atau perintah SQL pada properti Row 
Source di atas, lakukan dengan cara yang sama ketika Anda 
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membuat Lookup Agama pada table Anggota. Di sini Anda 
menggunakan table tbl_Anggota dan menambahkan field 
NomorAnggota dan NamaAnggota. Sort dilakukan Ascending 
pada field NomorAnggota. 
 

• Lookup Jenis Simpanan 

Lookup Jenis Simpanan didasarkan pada table Jenis Simpanan. 

Klik field JenisSimpanan lalu atur properti Lookup sebagai 
berikut: 

Display Control Combo Box 
Row Source Type Table/Query 
Row Source SELECT JenisSimpanan, 

NamaSimpanan  
FROM tbl_JenisSimpanan  
ORDER BY Urutan; 

Bound Column 1 
Column Count 2 
Column Widths 0cm;1cm 
List Width 1cm 
Limit To List Yes 

 

• Lookup Tahun 

Lookup Tahun disediakan agar pemakai bisa memilih periode 
tahun berdasarkan teks tampilannya, yaitu yang telah kita 
tentukan pada table Tahun. 

Klik field PeriodeTahun lalu atur properti Lookup sebagai berikut: 

Display Control Combo Box 
Row Source Type Table/Query 
Row Source tbl_Tahun 
Bound Column 1 
Column Count 2 
Column Widths 0cm;1cm 
List Width 1cm 
Limit To List Yes 
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• Lookup Bulan 

Lookup Bulan disediakan agar pemakai bisa memilih bulan 
berdasarkan namanya, yaitu yang telah kita tentukan pada table 
Bulan. 

Klik field PeriodeBulan lalu atur properti Lookup sebagai berikut: 

Display Control Combo Box 
Row Source Type Table/Query 
Row Source tbl_Bulan 
Bound Column 1 
Column Count 2 
Column Widths 0cm;1cm 
List Width 1cm 
Limit To List Yes 

 

3.5.3 Lookup pada Table Pengambilan Simpanan 

Selanjutnya bukalah table tbl_Simpanan_ambil dalam Design View, 
lalu buat Lookup sebagai berikut: 

• Lookup NomorAnggota 

Lookup Nomor Anggota disediakan agar pemakai tinggal me-
milih nomor anggota dari data yang disimpan pada table 
Anggota. 

Di sini kita bisa menampilkan dua buah kolom yaitu kolom 
nomor anggota dan kolom nama anggota. 

Klik field NomorAnggota lalu atur properti Lookup sebagai 
berikut: 

Display Control Combo Box 
Row Source Type Table/Query 
Row Source SELECT tbl_Anggota.NomorAnggota, 

tbl_Anggota.NamaAnggota FROM 
tbl_Anggota ORDER BY 
tbl_Anggota.NomorAnggota; 

Bound Column 1 
Column Count 2 
Column Widths 2cm;1cm 
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List Width 8cm 
Limit To List Yes 

• Lookup Jenis Simpanan 

Lookup Jenis Simpanan didasarkan pada table Jenis Simpanan. 

Klik field JenisSimpanan lalu atur properti Lookup sebagai 
berikut: 

Display Control Combo Box 
Row Source Type Table/Query 
Row Source SELECT JenisSimpanan, 

NamaSimpanan  
FROM tbl_JenisSimpanan  
ORDER BY Urutan; 

Bound Column 1 
Column Count 2 
Column Widths 0cm;1cm 
List Width 1cm 
Limit To List Yes 

 

3.5.4 Lookup pada Table SHU 

Lookup pada table SHU sama dengan Lookup pada table Simpanan 
sehingga Anda bisa membuatnya dengan cara yang sama. 

Adapun Lookup yang perlu dibuat adalah: 

• Lookup NomorAnggota 

• Lookup Tahun 

• Lookup Bulan 

3.5.5 Membuat Query Kota 

Query Kota adalah query yang dijadikan Row Source pada Lookup 
TempatLahir dan Lookup Kota pada table Anggota. 

Tata cara pembuatannya sebagai berikut. 
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1. Pada Access 2003: klik kategori object Queries pada jendela 
Database, lalu klik-ganda “Create query in Design view”. 

 

Gambar 3-31. Create query in Design view 

Pada Access 2007 atau Access 2010: klik ribbon tab Create, lalu 
klik “Query Design”. 

 

Gambar 3-32. Query Design pada ribbon tab Create 

2. Muncul Query Builder atau Query Design. 

Klik “Close” untuk menutup kotak Show Table tanpa menam-
bahkan table apa pun. 

3. Klik “SQL” pada toolbar atau ribon, atau klik menu View > SQL 
View. 

4. Ketik perintah SQL sebagai berikut. Perintah ini menggunakan 
subquery sehingga sulit dibuat dengan desain visual. 
SELECT Src.Kota 
FROM [SELECT TempatLahir As Kota FROM tbl_Anggota  
UNION SELECT Kota FROM tbl_Anggota]. AS Src 
GROUP BY Src.Kota 
HAVING (((Src.Kota) Is Not Null)) 
ORDER BY Src.Kota; 
 

5. Simpan query dengan nama: qry_Kota. 

Hingga di sini pembuatan Database Koperasi yang Anda lakukan 
sudah selesai dan siap digunakan. 
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3.6 Mengatasi Pesan Keamanan 
Di dalam pembuatan database seperti yang telah Anda lakukan pada 
bab ini, mungkin Anda pernah menutup file database atau Access, 
lalu Anda membuka file database kembali. Kemungkinan ketika 
Anda mebuka file database, Access akan menampilkan peringatan 
sebagai berikut: 

 

Gambar 3-33. Peringatan keamanan pada Access 2003 

 

Gambar 3-34. Peringatan keamanan pada Access 2007 

 

Gambar 3-35. Peringatan keamanan pada Access 2010 

Untuk mudahnya Anda tinggal klik “Open”, atau klik “Options” lalu 
memilih “Enable this content”, atau klik “Enable Content”. Namun 
demikian Anda bisa mencegah munculnya peringatan keamanan ini, 
yaitu dengan melakukan langkah-langkah pada subbab berikut. 
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3.6.1 Mengatasi Pesan Keamanan pada Access 2003 

Untuk mengatasi pesan keamanan pada Access 2003, terlebih 
dahulu Anda harus membuat sebuah Digital Certificate. Hal ini tidak 
perlu dilakukan pada komputer pemakai lain, atau jika Anda sudah 
mempunyai Digital Certificate. 

Untuk membuat sebuah Digital Certificate (buatan sendiri): 

1. Klik tombol Start > All Programs > Microsoft Office > Microsoft 
Office Tools > Digital Certificate for VBA Project. 

2. Muncul jendela Create Digital Certificate. 

 

Gambar 3-36. Membuat Digital Certificate sendiri 

Masukkan nama Anda atau identitas lain sebagai nama 
certificate. Klik “OK”. 

Selanjutnya: 

1. Pada jendela Database, tekan Alt+F11 untuk menampilkan 
Microsoft Visual Basic. 

2. Klik menu Tools > Digital Signature. Muncul jendela Digital 
Signature. 

3. Klik “Choose” lalu pilih certificate yang ingin digunakan. Klik 
“OK” 

4. Klik “OK” lagi lalu tutup jendela Microsoft Visual Basic. 
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Gambar 3-37. Memasang Digital Signature 

Sekarang tutuplah file database, lalu buka kembali. Akan muncul 
peringatan keamanan sebagai berikut: 

 

Gambar 3-38. Peringatan keamanan 

Pada saat ini Anda bisa langsung menandai opsi “Always trust…” 
dan mengklik “Open”. Peringatan ini tidak akan muncul lagi ketika 
Anda membuka file database kembali. 

Jika Anda menjalankan/membuka file database pada komputer 
pemakai lain, klik tombol “Details” lalu ikuti langkah-langkah untuk 
menginstal certificate pada komputer tersebut. Opsi “Always trust…” 
akan bisa dicentang ketika Anda membuka file database kembali. 
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3.6.2 Mengatasi Pesan Keamanan pada Access 2007  
dan Access 2010 

Untuk mengatasi pesan keamanan pada Access 2007 maupun 
Access 2010, ikuti langkah-langkah berikut: 

1. Klik tombol Office pada Access 2007, atau klik tab File pada 
Access 2010. 

2. Klik “Access Options” pada Access 2007, atau “Options” pada 
Access 2010. 

Muncul jendela Access Options. 

 

Gambar 3-39. Jendela Access Options 

3. Klik “Trust Center” lalu klik “Trust Center Settings”. Muncul 
jendela Trust Center. 
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Gambar 3-40. Jendela Trust Center 

4. Ada tiga pilihan yang tersedia untuk men-trust database, yaitu 
berdasarkan publisher (pembuat, dalam hal ini diwakili oleh 
digital signature yang dipasang pada database), lokasi (yaitu 
lokasi penyimpanan file database), dan dokumen (di mana Anda 
mengklik “Enable Content” pada baris pesan ketika file database 
dibuka). 

Pilihan yang umum digunakan adalah “Trusted Locations”, di 
mana Anda mendaftarkan lokasi penyimpanan database yang 
Anda percaya. File database yang disimpan pada lokasi tersebut 
akan dibuka tanpa baris pesan keamanan lagi. 

Untuk menambahkan sebuah lokasi sebagai lokasi yang di-
percaya, klik “Add new location” lalu tentukan alamat lokasi ter-
sebut. 

5. Klik “OK”. 

 

 

*** 
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